


C
O

N
T

EN
ID

O

UNIVERSIDAD NACIONAL AUTÓNOMA DE MÉXICO
Facultad de Ingeniería

PRÁCTICAS DE LABORATORIO 
DE LA ASIGNATURA 

DISPOSITIVOS ÓPTICOS

TEMAS: 
ANÁLISIS ESPECTRAL ÓPTICO

Y FILTRADO ÓPTICO DE SEÑALES

Coordinador:

Sergei Khotiaintsev

División de Ingeniería Eléctrica
Departamento de Ingeniería en Telecomunicaciones 



C
O

N
T

EN
ID

O

Khotiaintsev, Sergei (Coordinador). 

Prácticas de laboratorio de la asignatura Dispositivos ópticos. 

Temas: Análisis espectral óptico y Filtrado óptico de señales [Formato PDF]

Universidad Nacional Autónoma de México, 

Facultad de Ingeniería, 2020, 59 p.

Prácticas de laboratorio de la asignatura Dispositivos ópticos. 

Temas: Análisis espectral óptico y Filtrado óptico de señales

Primera edición electrónica de un ejemplar (9.2 MB) en formato PDF

Publicado en línea: 12 de febrero de 2020

D.R. © 2020, Universidad Nacional Autónoma de México, Avenida 

Universidad núm. 3000 Col. Universidad Nacional Autónoma de México, 

Ciudad Universitaria, Delegación Coyoacán, Ciudad de México, 

Código Postal 04510.

Facultad de Ingeniería

http://www.ingenieria.unam.mx/

Esta edición y sus características son propiedad de la Universidad Nacional 

Autónoma de México. Prohibida la reproducción o transmisión total o 

parcial por cualquier medio sin la autorización escrita del titular de los 

derechos patrimoniales. 

Hecho en México

Unidad de Apoyo Editorial

Cuidado de la edición: Amelia Guadalupe Fiel Rivera

Formación editorial: Nismet Díaz Ferro UNIDAD DE APOYO EDITORIAL

udae
años

an
ive

rs
ar

io



III

C
O

N
T

EN
ID

O

PREFACIO

La presente publicación fue realizada en el marco del proyecto Diseño de prác-
ticas virtuales y presenciales para el mejoramiento de enseñanza en algunas 
asignaturas de Ingeniería en Telecomunicaciones, patrocinado por la DGAPA-

PAPIME de la UNAM, con número de referencia PE104811. El proyecto consistió 
en desarrollar y aplicar una nueva filosofía para la implementación de prácticas 
de laboratorio, lo cual se describe a continuación. 

Se desarrolló una serie de protocolos de prácticas para cuatro asignaturas de la 
carrera de Ingeniería en Telecomunicaciones de la Facultad de Ingeniería: 

Dispositivos ópticos (Clave 2049)
Codificación de audio y video (Clave 0640)
Teoría de la información y la codificación (Clave 1684)
Análisis de señales aleatorias (Clave 1560)

Las asignaturas mencionadas tienen una característica en común: tratan acerca 
de la información y las señales (desde diferentes puntos de vista). El contenido 
de las cuatro asignaturas está correlacionado y, por tanto, el desarrollo de estas 
nuevas prácticas fue realizado de una forma coordinada e integral. 
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El equipo de trabajo que desarrolló los protocolos de la asignatura Dispositivos 

ópticos estuvo constituido el profesor de carrera del Departamento de Ingeniería 
en Telecomunicaciones de la División de Ingeniería Eléctrica de la Facultad 
de Ingeniería Dr. Sergei Khotiaintsev —responsable del Proyecto DGAPA-

PAPIME PE104811— y por la Dra. María del Carmen López Bautista, profesora 
de asignatura del mismo Departamento, con la participación de varios alum-
nos de Licenciatura y Posgrado en Ingeniería de la UNAM.

Las características novedosas de las prácticas de este manual consisten tanto en 
la forma como en el contenido de las actividades. En particular, se establece una 
metodología de acceso remoto a algunos elementos de las prácticas. Se ofrece 
a los estudiantes actividades virtuales que se realizan de forma remota, vía 
internet y actividades presenciales en el laboratorio. Todas las prácticas están 
estructuradas en cuatro fases:

	» Actividad previa (prepráctica): realización de una investigación teórica y 
revisión de temas, conceptos y material educativo específico necesario 
para el correcto y eficiente desarrollo de la práctica. Dentro de esta fase 
se contempla la ayuda de libros de texto recomendados, notas de curso y 
material virtual de apoyo: videos, animaciones, applets, etc. 

	» Reunión virtual del profesor con los estudiantes, en fecha y hora previamente 
pactadas, con el motivo de mostrar el equipo y material que se utilizará 
en la parte presencial, explicar su funcionamiento y hacer una demos-
tración del equipo disponible. 

	» Actividad presencial: realización de los experimentos físicos reales descri-
tos en el protocolo. 

	» Actividad posterior (pospráctica): elaboración del informe, conclusiones y 
análisis de resultados. 
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Las actividades virtuales se realizan por medio de internet; las reuniones virtua-
les, mediante un software multiplataforma de uso sencillo para efectuar reunio-
nes en línea, basado en el protocolo TCP/IP que permite el acceso en tiempo real 
a las reuniones de los integrantes del grupo académico e interacción de forma 
activa mediante voz IP desde cualquier dispositivo con conexión a internet: com-
putadoras de escritorio, computadoras portátiles, teléfonos celulares y tablets. 

Los principales beneficios que se brindan a los estudiantes, en esta modalidad 
de implementación de las prácticas, son los siguientes:

	» Mejora la preparación de los estudiantes para llevar a cabo la práctica y 
los resultados educativos que se obtienen son más amplios y sólidos. 

	» Facilita la realización de experimentos complejos o tardados. 
	» Fomenta la utilización de la tecnología como recurso para enriquecer el 

aprendizaje.
	» Relaciona de manera eficiente el conocimiento teórico con las tecnolo-

gías de Ingeniería en Telecomunicaciones.
	» Aumenta la responsabilidad del alumno por su propio aprendizaje, ade-

más de que se generan conocimientos adicionales a los provistos por la 
enseñanza tradicional. 

	» Uno de los beneficios más importantes consiste en que gracias a la nueva 
modalidad de implementación de las prácticas es posible poner a dispo-
sición de los estudiantes de licenciatura las instalaciones, equipo e ins-
trumentos de medición altamente especializados, adquiridos con fondos 
de diferentes proyectos de investigación científica y desarrollo tecnoló-
gico; esta infraestructura normalmente está destinada al desarrollo de 
dichos proyectos y trabajos de tesis de estudiantes de posgrado.
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Además, la Universidad y la academia obtienen los siguientes beneficios globales: 

	» Mejora la matrícula. 
	» Existe un aprovechamiento mayor de las tecnologías actualmente 

disponibles. 
	» Aumenta la demanda de empresas por egresados con mejor preparación 

y mayores conocimientos. 
	» Los egresados obtienen una ventaja competitiva al incorporarse al tra-

bajo profesional. 
	» Aumenta el prestigio de la carrera ante la comunidad. 

Agradezco profundamente a la Facultad de Ingeniería y los programas PASPA-

DGAPA, PAPIIT-DGAPA [proyectos IT102515 e IT101618] y PAPIME-DGAPA [pro-
yectos PE104811 y PE101616] de la UNAM por el apoyo en el desarrollo de esta 
serie de nuevas prácticas de laboratorio docente de la asignatura Dispositivos 

ópticos de la carrera de Ingeniería en Telecomunicaciones, así como a mis cole-
gas y estudiantes por su contribución al desarrollo, pruebas e implementación 
de las prácticas, los respectivos protocolos y este manual. 

Dr. Sergei Khotiaintsev
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FORMA DE DESARROLLO 
DE LA PRÁCTICA

La presente práctica tiene una metodología de trabajo autodidacta, enfocada en 
la autonomía del estudiante; las actividades se realizan en forma virtual y real, 
algunas a distancia y otras en forma presencial. 

El protocolo de la práctica prevé actividades virtuales con el software de simu-
lación, videos, animaciones y otros recursos de internet, así como un desarro-
llo en forma presencial en el laboratorio, con una opción de acceso remoto al 
ambiente de laboratorio y los equipos e instrumentos de medición de laborato-
rio utilizados en la práctica. 

Algunas actividades de la práctica pueden ser implementadas como un prela-
boratorio de carácter virtual, mientras que algunos experimentos pueden ser 
desarrollados de forma presencial en el laboratorio, así como algunas activida-
des más en un esquema de pos-laboratorio virtual. La decisión sobre la variante 
concreta de la implementación del presente protocolo la toma el profesor.

Posteriormente, el estudiante entregará al profesor el informe respectivo que 
contendrá los parámetros utilizados, el resultado de los cálculos y simulaciones 
previas, el código fuente de la solución al problema propuesto, así como los 
datos y resultados particulares de cada una de las actividades realizadas y la sec-
ción de conclusiones.
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REGLAS DE SEGURIDAD LABORAL1

Es indispensable que cada estudiante lea, conozca y cumpla con las Normas 
Oficiales Mexicanas, así como las normas internacionales que dan lineamientos 
para el manejo de riesgos en el ámbito industrial.[1-7] En estas normas se especi-
fican las medidas de seguridad necesarias para trabajar y evitar accidentes.

Las instalaciones de laboratorio incluyen varios equipos, unidades e instrumen-
tos de medición que tienen peligros inherentes que requieren un manejo cuida-
doso, tales como los cables y contactos de la red de energía eléctrica alterna de 
120 V AC 60 Hz, fuentes de alimentación de láseres de alto voltaje de hasta 3,000 V 

DC con sus cables y contactos, y láseres de diferentes tipos, niveles de potencia 
y distintos longitudes de onda, de la luz visible y radiación infrarroja (invisible), 
estas fuentes presentan un peligro potencial.

Adicionalmente, exigimos que todas las personas sigan estas reglas de seguri-
dad en nuestras instalaciones:

	» Está prohibido encender, utilizar y manipular los láseres y otras fuentes 
ópticas sin autorización del profesor que supervisa las actividades. 

1.	 NOTA: Todas las normas mencionadas se encuentran tanto en internet como impresas en el 
Departamento; también, cada estudiante puede acudir con el profesor para obtener una copia.
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	» El ojo, en particular la retina, pueden sufrir cambios irreversibles provo-
cados por la exposición de luz láser. Por esto, está absolutamente prohi-
bido mirar directamente el haz láser o dirigir el haz láser a las personas, 
incluyendo láseres de cualquiera potencia mínima. Sin embargo, no solo 
la explosión directa a los ojos o piel puede producir daños; el haz láser 
reflejado o disperso por un objeto que se encuentra en su trayecto tam-
bién es peligroso ya que pude producir daños irreversibles.

	» Algunos láseres emiten radiación no visible (ultravioleta o infrarroja), 
por lo cual no podemos percatarnos de su funcionamiento. En nuestras 
instalaciones hay láseres de dióxido de carbono (CO₂) de una longitud 
de onda de 10.6 micrómetros (IR) de hasta 25 watts de potencia CW del 
haz. Estos láseres pueden producir daño severo en caso de exposición 
directa, pero también debido a la reflexión sobre distintos objetos inclu-
yendo los objetos que no consideramos como espejos, ya que la reflec-
tancia de diversos materiales y objetos materiales es muy distinta en la 
banda visible, ultravioleta e infrarroja.

	» Por todo lo expuesto anteriormente, en el trabajo con láseres y otras 
fuentes ópticas es obligatorio utilizar lentes protectores apropiados a la 
longitud de onda de trabajo. En el caso de radiación infrarroja de 10.6 
micrómetros de láseres de CO₂, los anteojos industriales de vidrio, acrí-
lico y otros materiales plásticos transparentes protegen perfectamente 
bien nuestros ojos de dicha radiación.
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1. OBJETIVO GENERAL

El alumno comprenderá el funcionamiento, construcción y características de 
espectrómetros ópticos mediante experimentos virtuales y reales físicos pre-
senciales de laboratorio. Asimismo, desarrollará la capacidad para seleccionar y 
utilizar un espectrómetro óptico para la caracterización experimental de diver-
sas fuentes de radiación óptica de los sistemas modernos de telecomunicaciones 
ópticas.

2. OBJETIVOS PARTICULARES

	» Aplicar los métodos espectrométricos en la práctica.
	» Distinguir los elementos de un espectrómetro.
	» Conocer los parámetros que se utilizan en la espectrometría.
	» Interpretar los espectros de emisión de distintas fuentes de la radiación 

óptica.

3. MARCO TEÓRICO

La espectrometría es una de las técnicas experimentales más importantes de la 
caracterización de fuentes de radiación, elementos ópticos y diversos materia-
les por sus espectros de emisión, transmisión, absorción y reflexión.[8]-[15]

Los espectroscopios, espectrómetros y espectrofotómetros son instrumentos 
que se usan para el análisis espectral. La cantidad que se mide es generalmente 
la intensidad (potencia) absoluta o relativa de la radiación contra la longitud de 
onda de la radiación. Los espectrómetros también permiten medir las longitudes 
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de onda que corresponden a las líneas espectrales de emisión o absorción y 
otros elementos de interés en los espectros. Los espectrómetros funcionan en 
una amplia variedad de longitudes de onda, desde rayos gamma y rayos X hasta 
el infrarrojo lejano, aunque cada modelo cubre una banda particular espec-
tral. Esto por una notable diferencia en elementos que producen la dispersión 
espacial de la radiación, materiales ópticos, foto detectores, y técnicas de medi-
ción que se utilizan a longitudes de onda diferentes. Los espectrómetros de la 
banda visible y los que cubren también un rango cercano al espectro visible, 
que permiten mediciones absolutas de la intensidad de la radiación se llaman 
espectrofotómetros.

La obtención de espectros, es decir, la descomposición de la radiación óptica 
en sus componentes ópticos, se puede realizar por medio de dos efectos físicos: 
dispersión por la refracción (en un prisma) o dispersión por difracción (en una 
rejilla de difracción), como se muestra en la figura 1.

Figura 1. Obtención de espectros con un prisma y una rejilla de difracción [16]

Los primeros dispositivos espectrales fueron espectroscopios sencillos de un 
prisma con una escala y graduaciones que marcaban las longitudes de onda de 
la luz. Luego, el prisma se complementó con una abertura (rendija, hendidura) 
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de entrada, un colimador (un sistema que transforma un haz divergente a un 
haz “paralelo”), y un telescopio pequeño que facilita la observación del haz de 
salida (figura 2). 

Los espectrómetros contemporáneos generalmente usan dos o más prismas 
o rejillas de difracción en serie, una hendidura móvil para la selección de un 
intervalo espectral angosto, y un fotodetector (figura 3), o un arreglo lineal de 
foto detectores: típicamente un dispositivo de carga acoplada: Charge Coupled 

Device, CCD (figura 4). Los instrumentos más modernos están automatizados y 
controlados por la computadora.

Figura 2. Esquema de un espectroscopio sencillo

Figura 3.  Diagrama de un espectrofotómetro típico [17]
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En esta práctica, se estudian los espectros de emisión de distintas fuentes lumi-
nosas. Los estudios están basados en la medida de la radiación óptica emitida 
por un elemento, sustancia o material. 

4. CUESTIONARIO PREVIO

	» Define el espectro óptico.
	» ¿Qué es la espectrometría?
	» ¿Qué variables se miden en la espectrometría?
	» ¿Qué efectos físicos resultan en la descomposición de la radiación óptica 

en respectivo espectro?
	» ¿Qué tipos de espectrómetros existen?
	» ¿Qué elementos componen un espectrómetro?
	» ¿Cuáles son las características principales de un espectrómetro?

Figura  4.  Diagrama de un espectrómetrocon 
sensor lineal de carga acoplada [18]



6

C
O

N
T

EN
ID

O

	» ¿Cuáles son las ventajas y desventajas relativas de dos tipos básicos de 
espectrómetros? 

	» ¿Qué relación existe entre un espectro de absorción y de transmisión?
	» ¿Qué aplicaciones tiene la espectrometría y los espectrómetros en 

telecomunicaciones?
	» ¿Qué importancia tiene el espectro de emisión de una fuente óptica en 

aplicaciones en telecomunicaciones? 

5. MATERIAL

	» Espectrómetro Thorlabs CCS175[19]

	» Focos incandescentes
	» Diodos emisores de luz (LED) de diferentes colores
	» Láser de gas de He-Ne
	» Láser de semiconductor (Diodo láser) de gas
	» Computadora con el SPLICCO, el software del espectrómetro Thorlabs 

CCS175[20] instalado

6. EXPERIMENTO 1 (VIRTUAL)

6.1 Objetivos

	» Utilizando el software SPLICCO, analizar los espectros característicos de 
diferentes fuentes: focos, diodos emisores de luz y láseres de distintas 
longitudes de onda. 

	» Identificar las componentes espectrales de diferentes fuentes ópticas 
(focos, diodos emisores de luz y láseres).
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6.2.  Procedimiento

Descargar y estudiar el manual del software SPLICCO.[20]

1.	 Iniciar el software SPLICCO. 
2.	 A continuación, aparecerá una ventana en la cual hay que seleccionar 

la conexión al instrumento virtual y dar clic en Connect (véase figura 5). 
3.	 Enseguida, aparecerá la interfaz del software en donde se visualizará la 

gráfica del espectro que se desee (véase figura 6).
4.	 El siguiente paso es cargar un archivo con un espectro conocido. Para 

esto hay que seleccionar en el menú de File Open el archivo proporcio-
nado por el profesor y dar clic en Load.

5.	 Observando el espectro (figuras 7 y 8), hay que investigar qué tipo de 
fuente puede generar esa clase de espectro.

6.	 El espectro que está visualizando lo puede guardar como una imagen al 
ir al menú Tools/Take a Snapshot. 

7.	 Se puede guardar una tabla de valores correspondiente al espectro que 
está visualizando, al ir al menú Tools/Copy to Clipboard y pegar la tabla de 
registro por valores en un documento. 

8.	 Realizar el ejercicio por lo menos con 4 espectros diferentes.

	 Figura 5. Ventana del espectrómetro virtual de SPLICCO
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Figura 6. Interfaz de espectrómetro virtual de SPLICCO

Figura 7. Ejemplo de espectro de emisión de focos incandescentes:
focos de tungsteno-halógeno LS-1 y LS-1-LL [21]

Figura 8. Ejemplo de espectro de emisión un LED 
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7.   EXPERIMENTO 2 (FÍSICO Y PRESENCIAL) 

7.1  Objetivos

Estudiar espectros de emisión con el espectrómetro Thorlabs CCS175. 

Obtener el espectro de emisión de diferentes fuentes (focos, diodos emisores de 
luz y láseres) utilizando el espectrómetro Thorlabs CCS175. 

7.2  Procedimiento

1.	 Descargar y estudiar el manual del espectrómetro Thorlabs CCS175.[19]

2.	 Preparar el arreglo experimental de la figura 9.

Figura 9. Configuración de arreglo experimental para obtener 
el espectro de emisión de una fuente óptica

3.	 Correr el software del espectrómetro.
4.	 Encender la fuente de luz, y acoplar la fuente y la fibra óptica de entrada 

del espectrómetro.
5.	 Obtener el espectro de emisión de la fuente y guardarlo en un archivo. 
6.	 Repetir el paso 5 para cada fuente (focos, diodos emisores de luz y láseres).
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8.  CONTENIDO DEL INFORME DE LA PRÁCTICA

El informe debe incluir los resultados de cada una de las actividades realizadas:
	» Actividad previa a la realización de la práctica: soluciones del cuestiona-

rio previo e investigación de los conceptos vistos en la práctica.
	» Actividad virtual.
	» Actividad presencial.
	» Conclusiones.
	» Comentarios (Opcional).
	» El informe se entrega en forma impresa.
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ANEXO:

CCS175 SERIES OPERATION MANUAL

THORLABS SPECTROMETER CCS175

Se agradece a la empresa Thorlabs la cortesía de otorgar 
su autorización para reproducir con fines didácticos el contenido 

del presente manual

CCS Series Operation Manual
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THORLABS 
Spectrometer

CCS175
λ = 500 - 1000 nm

1. GENERAL INFORMATION

The CCS Spectrometer Series is designed for general laboratory use. Integrated 
routines allows averaging, smoothing, peak indexing, as well as saving and 
recalling data sets. The initial setup is simple to complete. Following installa-
tion of the software, the CSS spectrometer is ready to use. Simply plug it into 
a USB 2.0 port and run the application software SPLICCO. The remainder of 
this manual is devoted to the setup procedure and features of the fiber spec-
trometer. A troubleshooting section and detailed specifications of the various 
components are provided to further assist. The description of the instrument 
driver commands can be found in the VXIpnp VISA instrument driver package.

Application software SPLICCO

SPLICCO is an acronym for “SPectrometer and LIne Camera COntrol”. This 
software can be used for acquiring direct, transmittance and absorbance mea-
surements in conjunction with Thorlabs line cameras and spectrometers.
After the installation the software is able to communicate with all Thorlabs 
CCS spectrometers. Additionally, two virtual devices are included: a line cam-
era and a spectrometer, to demonstrate the functionality of SPLICCO.
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2. CCS SERIES OPERATING INSTRUCTIONS

Start the GUI

To start SPLICCO click on the desktop icon  or select ‘Programs’ via 
the START button in the Windows task bar and navigate to ‘All Programs / 
Thorlabs / SPLICCO / SPLICCO’.

CCS Spectrometer with all user relevant ports and signal LEDs

Connecting a device

1.	 To start a measurement with a CCS spectrometer, connect it to a USB 
port of your PC with the supplied cable.

2.	 Select ‘Connect...’ from the Devices menu or click to the Connect icon 
from the tool bar.
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The following window appears and shows all connected devices and addition-
ally two virtual devices. Now you can select a device to be used. A panel will be 
created according to your selection by default. If the “Create a device window 
automatically” option is not checked, please use the according panel icon from 
the main interface.

Press “Cancel” to leave this dialog and “Rescan” to scan the system again for 
new devices.

Every device can only be opened once. Devices already opened by SPLICCO are 
marked with the “running” status and are grayed out in the device selection 
dialog. Devices used by another application than SPLICCO are marked with the 
“locked” status.

Press “Open Window” to switch to the “Open Window” dialog to connect a 
window to an already running device.

Furthermore, you can start a virtual spectrometer, which can simulate a spec-
trum. Through this feature you can familiarize yourself with SPLICCO, without 
the need of a light source or signal. You can select to display or hide those vir-
tual devices by checking or unchecking the “Show virtual devices” box.

For a detailed description about the virtual devices refer to section Virtual devices.
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Integration time

The integration time represents how long the CCD interacts with incoming 
light. CCD pixels act like light buckets, gathering photons. The integration time 
displays the duration for which the bucket is open. For very bright sources, 
low integration times are required, whereas for weak sources, longer integra-
tion times should be used. As in the light bucket analogy, CCD pixels can be 
overfilled (“blooming”). This is called saturation and will cause the output to 
be misleading.

If no intensities are displayed, please enter the shortest integration 
time and increase it continuously until an intensity curve is displayed. 
As mentioned above, CCDs are very sensitive, and if over-exposure 
occurs, no intensity can be displayed.

Also, please make sure the background correction is disabled (see sec-
tion Background Correction)

Integration time can be set via the control on the lower left corner of the device 
window. The supported range is defined by the CCS Spectrometer and ranges 
from 10 μs to 60 seconds. The integration time input window uses milli sec-
onds, therefore the values of 0.01 ms – 60000 ms have to be used to cover the 
range. A window, which only shows a loaded from a file spectrum does not 
offer those controls in the left bottom corner.

A change of the integration time affects all windows connected to this device, 
which are then updated to show the same integration time.

Higher integration times results in higher peaks in the measurement data.
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Loading data

Previously captured and saved measurement scans can be reopened with 
SPLICCO without connecting a device. This can be done from the File menu by 
selecting “Open...” (  icon) or “Import CSV...”.

Opening a file

SPLICCO can load most JCAMP-DX files with file extension *.jdx either as a 
reference to use with the live measurement data or in an individual window to 
show formerly saved data.
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To open a *.jdx file, choose “Open” or click to the  icon. Choose the appro-
priate file using the Browse button, the selected file is shown in the preview 
window. Eventually, saved comments are shown in the “Comments” field.

X and Y Factors represent the resolution. The resolution of the X axis is 1 
pixel, the resolution of Y axis results from the resolution when the file was 
saved. By pressing Load the curve is opened in a new window.

The Load function is used also for loading a reference scan to the cur-
rent live window. Details are explained in section References.

Import data

To import measurement data from a *.csv file select ‘File -> Import CSV...’ from 
the menu.
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Please specify the character separating the x & y columns and choose which 
character marks the decimal position in the appearing window. Then click to 
Browse to select the required file:
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Click OK to confirm:

Clicking to Load imports the data to a new window.

Saving data

SPLICCO can save data either in JCAMP-DX or CSV format.

To save the measurement data to a JCAMP-DX file select ‘Save As ...’ from the 
File menu or click the button from the toolbar. A file dialog window appears 
and you can choose the filename and directory.

The file extension of this file is *.jdx. Additionally, you can choose the range 
to store and the resolution, which defines how many values are interpolated 
and saved to file. “High” means factor 2, “Low” means factor 0.5 and “Average” 
means factor 1. Text entered in the “Comments” field will be stored together 
with the data.
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Export Data

Measurement data can be exported to a *.csv file for use with e.g. Microsoft 
ExcelTM or MathLabTM. To export the current measurement data to a *.csv file 
select ‘Export CSV...’ from the File menu. A popup panel appears to choose the 
target directory, filename and the characters for “Separator” and “Decimal 

Point”. Reference data can be handled in the same way.

Device Settings

The Device settings dialog can be opened from the Device menu.
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Device Info

The tab Info contains information about manufacturer, device name, serial 
number and firmware revision.

Trigger mode

SPLICCO is able to generate internal trigger signals (SW) or use external trigger 
signals to take readings at defined time intervals.

You can set the trigger mode in the Device Settings, tab ‘Common’.

The control offers five trigger modes: SW Trigger Continuous, SW Trigger 
Single Shot, External Trigger Continuous, External Trigger Single Shot and the 
Idle mode. According to the trigger mode the status symbol and the trigger but-
ton in the bottom of each device windows changes. The trigger buttons labels 
shows the possible option, e.g. “Stop Loop”, “Scan 1x”, “Arm Trigger” or “---”.

Averaging 

Very noisy or weak signals can be amplified by adding several scans, which 
is known as averaging. SPLICCO provides two kinds of averaging - Gliding 
Average and Block Average. The averaging mode can be set in the Device 
Settings panel in the ‘Common’ tab.

The number of scans to average can be set in the bottom of the active panel:
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To the right of the number of scans to be averaged a status box is displayed, 
indicating the fill level of the buffer used for averaging.

Gliding Average

This method averages over the most recent number of scans and is being upda-
ted with every new scan. The advantage is that the graph is being updated with 
every scan.

Example: The number of scans to be averaged is set to 10. After starting acqui-
sition, the software calculates the average out of the first two data sets, then 
out of the first three sets and so on until the desired number (10) is reached. 
Then the first data set will be subtracted and the newest data set will be added 
to calculation of average. This can be seen also in the buffer fill level - it grows 
up to the max and stays there.
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Block Average

This method accumulates a number of scans, after that calculates the average, 
displays it and starts the averaging process from beginning. The display is 
updated only after n scans.

Display mode

CCS100 Series Spectrometers can use an internal wavelength calibration file to 
show the range in nanometers instead of pixels. SPLICCO supports two display 
modes regarding the scaling of the x axis - the x axis is shown in either nano-
meter or pixel.

Click to  icon in the toolbar and open the ‘Common’ tab: flip the switch to 
change between the display modes.
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Cursor control

SPLICCO provides a cursor for instantaneous readout of wavelength and ampli-
tude (intensity). In order to use this feature, right click on a graph and choose 
“Cursor mode”. The “Cursor mode” disables the “Zoom mode” and a vertical 
line appears. With the first left click on the graph a small window appears right 
beside the mouse cursor and shows the actual x-value and y-value. The preci-
sion is always the same as the precision of the corresponding axis.

Peak finder

SPLICCO offers the possibility to find peaks in an actual measurement. The 
peak finder can be selected by right clicking on the actual window and selecting 
“Peak finder...”

In order to specify the relevant peaks, a peak width and a peak threshold can be 
set. A higher threshold and a higher peak width will reduce the found peaks. 
By pressing the “Calculate” button the peaks specified by those two parameters 
are calculated and the list is filled with the found peaks.

Cursor control
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Peak finder

Specify the relevant peaks



27

C
O

N
T

EN
ID

O

The found peaks can be sorted by their location (“Wavelength/Pixel”) or by 
intensity (“Amplitude”) - just click to the desired header - and can be iterated 
with the help of the arrow buttons (“<<” and “>>”).

Only one peak can be marked at the same time, but you can export the full list 
into a tab separated text file with the “Export” button.

Logarithmic Y Scale

The intensity axis can be scaled linearly or logarithmical. Default display is lin-
ear, in order to switch to logarithmic just click the icon in the toolbar. Alterna-
tively, the Log Y Scale can be activated via the View menu or from the dialog 
after right clicking to the diagram area.

References

An actual scan can be stored as reference. This reference will appear in a 
different color (see Color Setup) and remains unchanged during the current 
SPLICCO session unless cleared.

Click the  icon in the toolbar, or select ‘Store as actual Reference’ from 
either the Tools menu or from dialog, which appears after a right click on the 
diagram area.

Delete a reference by selecting ‘Clear Reference’ or by clicking the  icon.
A scan can be saved as a *.jdx file for later use.
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Save a reference

	» Store the actual scan as reference. (te: In order to distinguish the refer-
ence scan in the following screenshot, the integration time was changed 
after defining the reference. Actually, the actual scan and the reference 
are congruent). 

	» Open the ‘Save As...’ menu, choose a location and file name, select ‘Data 

to store: Reference’ and click Save.
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Load a reference

	» Click the  icon in the toolbar, or select ‘Load Reference...’ from either 
the Tools menu or from dialog, which appears after right clicking the 
diagram area. A dialog box opens:

	» Browse for the file location, select the desired reference file and click 
Load.

	» The reference curve is copied into the actual window and can be used 
for future calculations.

Calculations with references

SPLICCO offers the possibility to recalculate the live measurement with a refe-
rence curve. This reference curve can be a sampled live curve or a curve loaded 
from a JCAMP-DX file as long as the ranges are compatible to each other. It is 
possible to calculate with a reference curve that only partly matches the range 
of the live measurement. In this case only the matching range is calculated and 
shown.
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There are four modes available:
Scope: The normal view
Relative difference: The relative changes with respect to reference or background
Absorbance: The absorbance view
Transmittance: The transmittance view

An example shall illustrate that. As reference, a spectrum in the range from 420 
to 660nm of a Thorlabs MCWHL2 mounted cold white LED was taken. Then, 
into the light path a Thorlabs NE06A neutral density filter (optical density 0.6, 
transmission 25%) was inserted.

Scope view

The scope view is the standard view in SPLICCO. The reference curve is shown 
as well as the original measurement data, no calculations made.
The blue curve is the reference (LED spectrum), the red curve represents the 
spectrum of the LED with the ND filter.

Relative difference measurement:

The relative difference view shows for each wavelength the live measurement 
values (I

meas

) divided by the reference curve values (I
ref 

), so that only changes in 
the spectrum are displayed. The original reference curve is still shown to allow 
an easy comparison. The original reference curve is still shown to allow an easy 
comparison.
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Transmittance:

The transmittance view shows the light transmission by a sample in %:
Please make sure, the Y axis is scaled to a convenient for display value (here to 
100%). The original reference curve is still shown 28 for comparison.

Absorbance:

The absorbance A, also known as optical density OD, describes the light absorp-
tion by a sample:
The original reference curve is still shown to allow an easy overview. 

Scope view
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Copy to Clipboard

The actual scan data can be copied to the clipboard via the menu Tools, choose 
Copy to Clipboard.

These data can be pasted to a different application, e.g. Microsoft EXCEL© , for 
further processing. The data are comma separated pairs of values, where the 
first value represents the pixel number (wavelength in nm), the second - the 
intensity measured at this pixel.

Snapshot

A Snapshot of the actual scan includes the actual scan diagram area and a 
header: 

	» device type and device label 
	» date and time 
	» user name 
	» settings for integration time and averaging counts 

To make a snapshot, choose Take a Snapshot from the menu Tools. A Select 
File dialog appears, asking for a file name and format. Snapshots can be saved 
as *.bmp, *.jpg or *.png files.

3. APPLICATION NOTE

This section hopes to aid the user, by giving tips or hints on how to obtain the 
best measurements with the CCS spectrometers. It begins with a few general 
suggestions and finishes by giving a choice of question with solutions.
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To obtain a good spectrum with minimum noise the light reaching the spec-
trometer should be maximized. Therefore, a clean fiber with minimum bends 
is of high importance. Fiber collimation packages, which physically fit to the 
SMA fiber, but are not designed for Multimode fibers might be less efficient 
than just the SMA connector in front of the sample.

In some cases a small variation in the diameter of the SMA ferule, might lead to 
a tilted fixture of the connector in the fiber port. In this case loosen the fiber 
connector a few turns and reconnect it.

For a good signal to noise (S/N) ratio, it is recommended to have the spectral 
data of interest in between 70% and 95% of the intensity scale (0.7 - 0.95). This 
ensures that the signal is above the background noise, but not overexposed. 
You can identify an overexposed signal by the increased line width and a cha-
racteristic plateau of the signal maximum.
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If your signal looks similar to the sample in the above figure, decrease the inte-
gration time to get a maximum peak intensity in between 0.9 and 1.0. If your 
signal is still overexposed at the minimum integration time of 10 μs, it is rec-
ommended to use neutral density filters or other optical attenuator in front of 
the light source to decrease its intensity.

If the signal you are evaluating is very small, you can increase the integration 
time. As shown in the next figures, this way the peak intensity raises from 
~ 0.018 (equal to 1.8% of the max. intensity) to about 0.7 (70%), which is a 
recommended value.

       Scan, recorded at 300ms integration time

If you are already at the maximum or if other parameters of your experiment 
do not permit long exposures, you can also use the averaging function to raise 
you signal above the noise. The result can be seen in the following figures. 
Please note, that the intensity is around 0.018 which corresponds to 1.8% of the 
available intensity scale.
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Scan, recorded at 7ms integration time and 10 averages

Blooming

A property owned by all CCD sensors, as used in the CCS spectrometers, is 
blooming.

Strongly overexposed pixels tend to discharge neighboring/adjacent pixels, 
even if they are not illuminated. This can be seen in the spectra by an increased 
line width, which could lead to misinterpretations of the signal. You can avoid 
this effect by decreasing the integration time or using optical attenuators, as 
described above.

Maintenance and Service

Protect the CCS spectrometer from adverse weather conditions. The CCS spec-
trometer series is not water resistant.
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Attention

To avoid damage to the spectrometer, do not expose it 

to spray, liquids or solvents!

The unit does not need a regular maintenance by the user.

If necessary the unit and the display can be cleaned with a cloth dampened with 
water.

4.  TECHNICAL DATA

Item CCS150 CCS100 CCS175 CCS200

Optical Specs

Wavelength 
Range

200-400 1) 350-700nm 500-1000nm 200-1000nm

Spectral 
Resolution

<0.4nm 
FWHM @ 

365nm

<0.5nm 
FWHM @ 

435nm

<0.6nm 
FWHM @ 

633nm

<2nm FWHM 
@ 633nm

Slit (WxH) 20 µm × 2 mm

Grating
1800 Lines/mm

240nm Blaze
1200 Lines/mm

500nm Blaze
830 Lines/mm
800nm Blaze

600 Lines/mm
800nm Blaze

Sensor Specs

Detector Range
(CCD Chip)

20-100nm 350-1100nm 200-100nm

CCD Pixel Size 8 µm × 200 µm (8 µm pitch)

CCD Sensitivity 160 V/(lx · s)

CCD Dynamic 
Range

300
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Item CCS150 CCS100 CCS175 CCS200

CCD Pixel 
number

3648

Resolution 12 px/nm 10 px/nm 6 px/nm 4 px/nm

Integration Time 10µs – 60s

Scan Rate Max. 200 Scans/s 2)

S/N ratio ≤ 2000:1

External Trigger

Fiber Connector SMA 905

Trigger Input SMB

Trigger Signal TTL

Trigger 
Frequency Max.

100 Hz

Trigger Plus 
Length Min.

0.5 µs

Trigger Delay 8.125µs ± 125ns

General Specs

Interface Hi-Speed USB2.0 (480 mbit/s)

Dimensions 
(LxWxH)

122 × 80 × 30 mm

Weight < 0.4 Kg
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Práctica

FILTRADO ÓPTICO 
DE SEÑALES

AUTORES: 

Sergei Khotiaintsev

María del Carmen López Bautista
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1. OBJETIVOS GENERALES 

El alumno comprenderá los principios de la colorimetría y el filtrado óptico. 
Identificará y analizará adecuadamente los espectros de transmisión y absor-
ción de dispositivos activos y pasivos de línea de fibra óptica. Además, cono-
cerá los espectrofotómetros y técnicas de caracterización experimental de los 
espectros de distintos dispositivos ópticos utilizados en la práctica.

2. OBJETIVOS PARTICULARES

1.	 Identificar las características de diferentes filtros ópticos en forma 
práctica.

2.	 Reconocer las diferencias entre los espectros de transmisión y absorción 
de distintas sustancias, materiales y filtros ópticos de distintos tipos y 
modelos.

3.	 Utilizar los fundamentos de colorimetría en forma práctica. 
4.	 Manejar eficientemente un espectrofotómetro en mediciones de espec-

tros de transmisión y absorción.

3. MARCO TEÓRICO 

Un filtro óptico es un medio que solo permite el paso a través de él de radiación 
óptica de algunas longitudes de onda, suprimiendo (atenuando) la radiación en 
función de su longitud de onda.[1]-[5] Los filtros ópticos más comunes son los 
filtros de color, es decir, aquellos que solo transmiten luz de un determinado 
color (intervalo de longitudes de onda). Si se limitan a atenuar la luz uniforme-
mente en todo el rango de frecuencias, se denominan filtros de densidad neutra 
o filtros grises.
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Según su principio de funcionamiento, pueden ser de absorción si absorben 
parte de la luz. Los filtros de absorción se elaboran mezclado un colorante (sus-
tancia con propiedades absorbentes de la luz): óxidos o sales de algunos meta-
les, con una matriz de vidrio o polímero. Son iones de metales, por ejemplo, 
Cu++, Ni++, Fe++, Fe+++, Cd++, y algunos otros que absorben selectivamente la luz 
y dan color al vidrio, plástico o gel. 

El espectro de filtros de absorción es bastante ancho (figura 1). Por tal motivo, su 
uso está limitado a la fotografía, el arte en general, iluminación, etc., (figuras 2 y 
3). Considerando el gran ancho de su espectro, los filtros de absorción no sirven 
para aplicaciones exigentes de filtrado de señales ópticas en telecomunicaciones. 

Figura 1. Espectros de transmisión de algunos filtros de absorción [6]

Figura 2. Algunos filtros de absorción de paso banda [6]
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Figura 3. Filtros de absorción montados para lentes fotográficas [6]

El ancho espectral angosto, de decenas de nanómetros [nm] hasta unos picóme-
tros [pm], se obtiene en los filtros interferométricos (dicroicos). Su principio 
de funcionamiento, la respuesta espectral típica y la forma física se demuestran 
en las figuras 4, 5 y 6.[7]

Figura 4. Esquema de un filtro o espejo interferométrico (dicroico) [7]
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Figura 5. Ejemplo de espectro de transmisión de un filtro interferométrico [6]

Figura 6. Algunos filtros interferométricos o dicroicos [6]

Los filtros interferométricos se utilizan ampliamente en instrumentos científi-
cos, en estudios de astronomía, biología y otras ciencias. Son una parte esencial 
de láseres, en los cuales este tipo de filtros permiten controlar las frecuencias 
de emisión de estos generadores cuánticos. En telecomunicaciones, se utili-
zan los filtros ópticos interferométricos en los sistemas de comunicaciones por 
fibra óptica WDM para la separación de canales espectrales, en amplificadores 
ópticos EDFA (Erbium Doped Fiber Amplifier) para igualación de ganancia en su 
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banda de operación, en forma de rejillas de Bragg grabadas en el núcleo de una 
fibra óptica para el filtrado de señales, etc.

La caracterización de los filtros igual que sustancias y materiales parcialmente 
transparentes se hace por medio de análisis espectral de la radiación óptica que 
atravesó o rebotó de la muestra bajo estudio. Los espectros de transmisión, 
absorción y reflexión de distintos filtros se miden con espectrómetros y espec-
trofotómetros (véase el protocolo de la práctica Análisis Espectral Óptico). 

A continuación, se ofrece una breve descripción de espectrometría de absor-
ción. Se considera que se dispone de la fuente de radiación óptica de longitud 
de onda λ, cuya potencia es P0. La muestra de espesor b absorbe una parte de la 
radiación incidente. Después de atravesar la muestra la potencia de radiación 
óptica es P. La razón entre la potencia de salida P y la de entrada P0, se define 
como transmitancia:

T = P/P0

La absorbancia se define como el logaritmo de la transmitancia, cambiado de 
signo:

A = log(P0/P) = –log T

A la muestra que no absorbe la radiación óptica, corresponde A = 0 y T = 1. 

A la muestra que transmite solo 1% de radiación, corresponde T = 0.01, P = P/100 
y A = 2.

Al incidir sobre algunos objetos, la radiación óptica puede ser totalmente absor-
bida o totalmente reflejada (consideramos los casos ideales). En el primer caso, 
el objeto aparecerá de color negro. En el segundo caso, el objeto aparecerá de 
color blanco. 
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Los seres humanos comúnmente perciben los objetos por medio de la luz refle-
jada; si un objeto absorbe ciertas longitudes de onda y refleja otras, estas últi-
mas determinan el color del objeto. El color observado es la diferencia entre el 
espectro incidente y el espectro absorbido por el objeto.

La percepción de colores por los humanos es el objeto de la ciencia y tecnología 
de la colorimetría. La colorimetría maneja dos modelos o sistemas diferentes 
para cuantificar la percepción de colores por las personas: 1. Sistema aditivo y 
2. Sistema sustractivo. 

El sistema de color aditivo se basa en fuentes de luz de diferentes longitudes de 
onda que se agregan en varias proporciones para producir una gama de colores. 
Las luces componente pueden ser luz de color blanco o luz que ha pasado a tra-
vés de filtros de color sustractivos adecuados; su combinación es un color adi-
tivo. Por lo general, tres colores primarios se combinan para estimular la visión 
de color de los seres humanos, detectados por los tres tipos de células de cono 
en el ojo, dando una gama aparentemente completa de colores, figura 7(a).

 
                         

(a)                                                             (b)

Figura 7. Síntesis aditiva (a) [8] y sustractiva (b) de colores [9]

Un modelo de color sustractivo explica la mezcla de un conjunto limitado de 
colorantes, tintas y pigmentos para crear una gama amplia de colores, cada uno 
da como resultado de restar parcial o completamente (es decir, absorber) algunas 
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longitudes de onda de la luz. El color que muestra una superficie depende de 
qué partes del espectro visible no son absorbidas y, por lo tanto, permanecen 
visibles. El sistema de color sustractivo empieza con la luz blanca. Las tintas, 
pinturas o filtros entre la fuente de luz y superficie reflectante restan algunas 
longitudes de onda de la luz, que le da color, figura 7(b). 

Los filtros ópticos se emplean tanto en sistemas de color aditivos como sustrac-
tivos. Para el filtrado de señales y aplicaciones de filtros ópticos en comunica-
ciones por fibra óptica, sugerimos referirse a las fuentes especializadas en esta 
materia.[10]-[12] 

4.  CUESTIONARIO PREVIO

	» ¿Qué tipos de filtros ópticos existen?
	» ¿En qué consiste la diferencia entre características de los filtros de dis-

tintos tipos?
	» ¿A qué se debe el color de un filtro de absorción?
	» ¿Qué relación tiene el color de un filtro de absorción con la longitud de 

onda absorbida?
	» ¿Qué parámetros se utilizan para describir y cuantificar un espectro de 

emisión o absorción?
	» ¿Qué es un sistema (modelo) de color aditivo?
	»  ¿Qué es un sistema (modelo) de color sustractivo?
	» ¿Qué aplicaciones tienen los filtros ópticos en el área de comunicaciones 

ópticas?
	» ¿Qué tipos de filtros se utilizan en sistemas de comunicaciones por fibra 

óptica?
	» ¿Qué importancia tiene el espectro de absorción de una fibra óptica en 

comunicaciones por fibra óptica?
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5.  MATERIAL

	» Applet de colorimetría.[13]

	» Espectrofotómetro marca Ocean Optics modelo USB4000.
	» Software de espectrofotómetro.
	» Computadora.
	» Fuente de luz blanca.
	» Conjunto de filtros ópticos.

6. EXPERIMENTO 1: COLORIMETRÍA (VIRTUAL)

6.1.  Objetivos

	» Comprender los conceptos básicos de colorimetría.
	» Realizar la adición y sustracción de colores, comprobar la ley de propor-

cionalidad y la adición y sustracción de colores por medio de experimen-
tos virtuales y cálculo de valores triestímulo.

6.2. Procedimiento

1.	 Correr el Applet de colorimetría (véase la interfaz en la figura 8). El 
Applet de colorimetría es un programa que permite la realización de 
simulaciones numéricas, de cómo se forma un color a través de la mezcla 
aditiva o sustractiva de colores primarios. La interfaz de Applet consta 
de tres pestañas, las cuales al seleccionarlas permiten correr diferentes 
módulos del Applet. 

2.	 El diagrama de colores de la figura 8 es el diagrama de cromaticidad de 
espacio de colores; representa tres colores primarios (rojo, verde y azul), 
y los colores que se obtienen por mezcla de ellos.
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3.	 Seleccionar Mezcla aditiva (figura 9) y observar en la parte izquierda el 
color problema, modificar la mezcla de los colores rojo, verde y azul 
hasta llegar al color problema. 

Figura 8. Interfaz de Applet de colorimetría con diagrama de cromaticidad 
de espacio de colores

4.	 Reporta la mezcla de colores, la longitud de onda dominante y la pureza.

Figura 9. Interfaz de Applet: mezcla aditiva de colores
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5.	 Seleccionar Mezcla sustractiva (figura 10), obtener el color problema. Esta 
mezcla consiste, al contrario de la anterior, en que a un color determi-
nado, formado por varias longitudes de onda, se le quitan algunas de estas 
(que por sí solas formarían otro color) y, por lo tanto, al modificar su 
contenido espectral, el color resultante es totalmente diferente del inicial. 

Figura 10. Interfaz de Applet: mezcla sustractiva de colores

6.	 Reporta la mezcla de colores, la longitud de onda dominante y la pureza.

7. EXPERIMENTO 2 (FÍSICO Y PRESENCIAL)

7.1.  Objetivos

	» Comprender los conceptos básicos de los filtros y filtrado óptico.
	» Identificar las similitudes y diferencias entre espectros de transmisión, 

reflexión y absorción.
	»  Demostrar en forma práctica cómo se obtiene los espectros de trans-

misión, reflexión y absorción de distintas sustancias, materiales y filtros 
ópticos de distintos tipos y modelos, empleando un espectrofotómetro.

	» Interpretar los espectros obtenidos experimentalmente. 
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7.2  Procedimiento

1.	 Conocer las normas de seguridad laboral en el trabajo con láseres y las 
normas de seguridad en el trabajo con instalaciones eléctricas, así como 
otras relevantes al trabajo en un laboratorio.[14]-[19]

2.	 Familiarizarse con el espectrofotómetro, conocer su empleo y medidas 
de seguridad.

3.	 Preparar el arreglo experimental de la figura 11.
4.	 Encender la fuente de luz y el espectrofotómetro. Realizar la medi-

ción de la muestra sin filtros (muestra de referencia luz blanca) con el 
espectrómetro.

5.	 Obtener el espectro de transmisión de la muestra por medio del espec-
trofotómetro y anotar la longitud de onda central de dicho espectro. 

6.	 Determinar el ancho espectral del espectro obtenido y compararlo con 
el de los datos bibliográficos. Registrar los resultados.

Figura 11. Esquema de medición de espectros de transmisión y absorción
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8.  CONTENIDO DEL INFORME DE LA PRÁCTICA

El informe debe contar con los resultados de cada una de las actividades 
realizadas:

	» Actividad previa a la práctica: soluciones del cuestionario previo e inves-
tigación de los conceptos vistos en esta práctica

	» Resultados de la actividad virtual
	» Resultados de la actividad presencial
	» Conclusiones
	» Comentarios (opcionales)

El informe se entrega en forma impresa.
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ANEXO:

ESPECTRÓMETRO USB4000. 

INSTALACIÓN Y OPERACIÓN
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1. Introducción

El USB4000 es un espectrómetro de alto desempeño en miniatura, con una 
entrada de fibra óptica, un fotodetector CCD y electrónica de alta velocidad. 
Cuenta una interface compatible con los sistemas operativos Linux, Macintosh 
y Windows. 

En principio, el modelo USB4000 es capaz de trabajar en el intervalo longitud 
de onda de 200 a 1100 nm, sin embargo, el rango específico y la resolución 
depende de la selección de la abertura de entrada y de la rejilla de difracción. 

Figura 1. Espectrómetro marca Ocean Optics modelo USB4000

2. Requerimientos del sistema

Se puede usar la conectividad USB del espectrómetro USB4000 con cualquiera 
computadora que cumpla con los siguientes requisitos.

	» Sistema operativo:
•	 Windows-98/Me/2000/XP
•	 Apple Macintosh- OS X versión 10.0 o posterior
•	 Linux- Red Hat 9 o posterior, Fedora (cualquier versión), Debian 3.2 

(Sarge), y SUSE (9.0 o posterior)
	» Instalación y configuración del software Ocean Optics Spectra Suite.
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3.  Instalación del espectrómetro USB4000

Se debe instalar la aplicación Spectra Suite antes de conectar el espectrómetro 
USB4000 a la computadora. Si no se instala el software primero, el sistema no 
reconocerá el espectrómetro apropiadamente. Esta sección contiene las ins-
trucciones para conectar el espectrómetro vía USB y puerto serial.

3.1. Conexión con el puerto USB

Pasos para conectar el USB4000 a la computadora vía puerto USB:
	» Instalar la aplicación Spectra Suite en la computadora a emplear.
	» Ubicar el cable USB (USB-CBL-1) proporcionado con el espectrómetro.
	» Insertar la terminación cuadrada del cable en el espectrómetro.
	» Insertar la terminación rectangular del cable en el puerto USB de la 

computadora.

Si se instaló correctamente la aplicación y se ha iniciado el Spectra Suite, el 
espectrómetro ya está adquiriendo datos. Incluso sin una fuente de luz en el 
espectrómetro, debe observarse una señal en la parte inferior de la gráfica. Si se 
introduce luz al espectrómetro, la señal trazada en la pantalla debe crecer según 
sea la intensidad de la luz. Esto indica que el software y el hardware se instala-
ron correctamente. 

3.2.  Conexión con el puerto serial

Para utilizar el puerto serial del espectrómetro USB4000, la computadora debe 
trabajar con la versión de Windows de 32-bit.
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Siga los siguientes pasos para conectar el USB4000 a la computadora vía puerto 
serial:

	» Conectar el adaptador del cable serial en los pines apropiados del conec-
tor de 22 pines del USB4000.

	» Conectar uno de los extremos del cable serial de 9 pines al adapta-
dor del USB400, después conectar el otro extremo al puerto serial de la 
computadora.

	» Anotar el número del puerto serial (COM puerto) al cual se conectó el 
USB400, en caso de que la computadora tenga más de un puerto serial.

	» Conectar el suministro de energía externo de5 VDC a la salida y conéc-
telo al USB400.

Figura 2. Espectrómetro USB4000. 1 – Conector de fibra óptica, 2 – abertura de entrada, 3 – 
filtro óptico, 4 – Espejo colimador, 5 – Rejilla de difracción, 6 – Espejo de enfoque, 7 – Lente 

(opcional), 8 - Foto detector CCD, 9 -  filtros ópticos bloqueadores, 10 – ventana UV.

4.  Funcionamiento del USB4000

La figura 2 muestra cómo viaja la luz en el banco del espectrómetro USB4000. El 
banco óptico no tiene partes móviles, todos los elementos se fijan en el proceso 
de manufactura. 
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Tabla A1. Elementos de USB4000 y sus funciones

# Elemento Función

1
Conector de fibra 
óptica SMA 905

Asegura la fibra de entrada al espectrómetro. La 
luz de la fibra de entrada entra al banco óptico a 
través de este conector.

2
Abertura de 
entrada

Una placa oscura de metal contiene una abertura 
rectangular; se monta detrás del conector 1. El 
tamaño de la abertura (de 5μm a 200μm) regula la 
cantidad de luz que entra al banco óptico y con-
trola la resolución espectral. 

3 Filtro óptico

La luz pasa a través del filtro antes de entrar al 
banco óptico. El filtro restringe el espectro de 
la radiación óptica a una banda: un intervalo de 
longitud de onda predeterminado. 

4 Espejo colimador
Enfoca la luz entrante al banco óptico hacia la 
rejilla de difracción 5. 

5
Rejilla de 
difracción

Difracta la luz y dirige la luz difractada al espejo 
de enfoque 6. 

6 Espejo de enfoque
Recibe la luz reflejada de la rejilla 5 y enfoca el 
espectro de difracción de primer orden en la 
superficie del fotodetector.

7 Lente opcional
Una lente opcional que se añade al detector para 
incrementar la eficiencia de concentración de la 
luz en la superficie de foto detector 8.

8
Foto Detector 
(UV o VIS)

Convierte la radiación óptica a una señal eléctrica 
digital. Es un sensor CCD lineal de 3648 pixeles. A 
cada pixel incide un pequeño intervalo (1/3684) 
de espectro incidente, produciendo una señal 
eléctrica digital de salida.

9 Filtros 
Filtros ópticos opcionales que bloquean el 
segundo y tercer orden de difracción.

10 Ventana UV 
Ventana opcional de cuarzo fundido que permite 
la operación del espectrómetro en la banda ultra-
violeta <340nm. 
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Tabla A2. Especificaciones del espectrómetro USB4000

Especificación Valor

Dimensiones 89.1 mm × 63.3 mm × 34.4 mm 

Peso 190 g 

Consumo de energía 250 mA @ 5 VDC 

Detector Arreglo lineal CCD de 3648 elementos 

Rango espectral 
del detector 

200-1100 nm 

Rejillas 14 rejillas de diferente ancho disponibles

Apertura de entrada Aperturas de 5, 10, 25, 50, 100, y 200 μm de ancho

Filtros de orden Filtros paso altas y paso banda 

Longitud focal 42 mm en la entrada; 68 mm en la salida 

Resolución óptica Depende de la rejilla y tamaño de la rejilla de entrada 

Tiempo 
de integración 

3.8 ms a 10 segundos (límite del detector ~15 sec) 

Interfaces USB 2.0, 480 Mbps; RS-232 (2-wisre) 
@ 115.2 K baud 

Sistemas operativos Windows 98/Me/2000/XP, Mac OS X, and Linux 
al usar el puerto  USB. Cualquier sistema Windows 
a 32-bit al usar el puerto serial. 

Tabla A3. Especificaciones del fotodetector CCD

Foto Detector Arreglo lineal CCD - Toshiba TCD1304AP 

No. de elementos 3648 pixeles 

Tamaño del pixel 8 μm × 200 μm 

Profundidad del pixel ~100,000 electrones

Relación señal a ruido 300:1

Resolución A/D 16 bit 

Linealidad corregida >99.8% 



C
O

N
T

EN
ID

O
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